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1. Introduction 

What is Scene Layers? 
Scene Layers is a professional Unity Editor tool that brings layer-based organization to your 
scenes. It provides an intuitive way to organize, hide, lock, and manage GameObjects 
without modifying your hierarchy structure. 

Key Benefits 
●​ Organize thousands of objects without hierarchy clutter 
●​ Toggle visibility for entire groups instantly 
●​ Lock layers to prevent accidental edits 
●​ Save and restore visibility states 
●​ Auto-assign objects based on components 
●​ Share layer setups across scenes 
●​ Color-code your hierarchy for visual clarity 



Core Concepts 
Layers Named groups of GameObjects that can be shown, hidden, and locked 
independently. Objects can belong to multiple layers simultaneously. 
 
Layer Views Saved visibility states that let you instantly switch between different working 
modes (e.g., "Layout Mode", "Lighting Mode", "Final Review"). 
 
Auto-Assign Rules Automatic assignment of objects to layers based on what components 
they have (e.g., all Lights go to Lighting layer). 
 
Layer Presets Reusable layer configurations that can be saved and loaded across different 
scenes, perfect for maintaining consistency in team projects. 
 
Per-Scene Databases Each scene has its own independent layer setup, stored alongside 
the scene file. No conflicts when switching scenes. 

Design Philosophy 
Scene Layers is designed to: 
 

●​ Work alongside Unity's hierarchy, not replace it 
●​ Be completely non-destructive (doesn't modify GameObjects) 
●​ Store data per-scene for maximum flexibility 
●​ Feel intuitive for artists, designers, and programmers 
●​ Minimize clicks and maximize efficiency 
●​ Support both solo developers and team workflows 

Unity Version Support 
●​ Minimum: Unity 2021.3 LTS 
●​ Recommended: Unity 2022.3 LTS or later 
●​ Tested: 2021 LTS, 2022 LTS, 2023 LTS, 2024+ 

 
Compatible with all render pipelines: Built-in, URP, and HDRP. 

2. Getting Started 

Installation 

Unity Package Manager 
1.​ Download the Scene Layers package 
2.​ In Unity, go to Assets > Import Package > Custom Package 
3.​ Select the downloaded package 
4.​ Click Import to import all files 



Verify Installation 
1.​ Open Unity 
2.​ Check that Window > Scene Layers menu appears 
3.​ You should see two menu items: • Layer Manager • Options 

Opening the Window 
Method 1: Menu Window > Scene Layers > Layer Manager 
 
Method 2: Right-Click Right-click in the Hierarchy window and select Scene Layers > Layer 
Manager (if configured) 
 
The window can be docked anywhere in your Unity layout, just like other Unity windows. 

Interface Overview 
The Scene Layers window has three main sections: 

Top Section: Layer Views 
●​ Quick-access buttons for saved visibility states 
●​ Settings icon (⚙) to manage views 
●​ Save icon (💾) to create new views 

Middle Section: Layers 
●​ Search bar to filter layers and objects 
●​ Layer list with expand/collapse 
●​ Each layer shows visibility, lock status, and object count 
●​ Drag handles for reordering 

Bottom Section: New Layer Button 
●​ Always-visible button to create new layers 
●​ Matches Unity's "Add Component" style 

Your First Layer 
Let's create a simple layer setup: 

Step 1: Create a Layer 
1.​ Click the "New Layer" button at the bottom 
2.​ Enter a name: "Environment" 
3.​ Choose a color: Green 
4.​ Press Enter or click Create 

Step 2: Add Objects 
1.​ Select some GameObjects in your scene (trees, terrain, buildings) 



2.​ Drag them onto the "Environment" layer header 
3.​ The layer now shows the number of objects: "Environment (5)" 

Step 3: Use the Layer 
1.​ Click the 👁 eye icon - all environment objects hide 
2.​ Click it again - they reappear 
3.​ Click the 🔒 lock icon - you can't select environment objects 
4.​ Click it again - selection is re-enabled 

Step 4: Expand the Layer 
1.​ Click the layer name or the ▶ arrow 
2.​ You see all 5 objects in a list 
3.​ Each object has its own visibility and lock controls 

First View 
Now let's save this state: 

Create a View 
1.​ With environment visible, click the 💾 Save icon at top 
2.​ Name it: "Full Scene" 
3.​ Choose a color: Blue 
4.​ Click Save 

Test the View 
1.​ Hide the environment layer (click 👁) 
2.​ Click the "Full Scene" view button 
3.​ Environment becomes visible again 

 
Views remember the exact state of all layers, making it easy to switch between different 
working modes. 

3. Layer Management 

Creating Layers 

Method 1: New Layer Button (Recommended) 
1.​ Click "New Layer" at the bottom of the window 
2.​ Enter a descriptive name 
3.​ Choose a color that represents the layer's purpose 
4.​ Press Enter or click Create 

 
Naming Tips: 



 
●​ Use clear, descriptive names: "Lighting" not "Layer1" 
●​ Include category prefixes: "ENV Terrain", "ENV Props" 
●​ Keep names short for better display: "UI" not "User Interface Elements" 

Method 2: Context Menu 
1.​ Right-click in the layer list 
2.​ Select "Create New Layer" (if available) 

Method 3: Keyboard Shortcut 
If configured, press your assigned hotkey to create a layer. 

Layer Header 
Each layer header displays important information and controls: 

Left Side: Status Icons 
Foldout Arrow (▼/▶) 
 

●​ Click to expand/collapse the layer 
●​ Shows all objects in the layer when expanded 
●​ Collapsed: ▶ Expanded: ▼ 

 
Eye Icon (👁) 
 

●​ Shows whether layer is visible 
●​ Click to toggle visibility for all objects 
●​ Open eye: Visible, Closed eye: Hidden 

 
Lock Icon (🔒) 
 

●​ Shows whether layer is pickable (selectable) 
●​ Click to toggle picking for all objects 
●​ Open lock: Pickable, Closed lock: Locked 

Center: Layer Information 
Layer Name 
 

●​ Shows the layer's name 
●​ Double-click to rename 
●​ Right-click for context menu 

 
Object Count (##) 
 

●​ Shows number of objects in layer 
●​ Updates automatically 



●​ Helps track layer size 

Right Side: Action Buttons 
Select All (★) 
 

●​ Selects all objects in the layer 
●​ Useful for bulk operations 
●​ Also pings the first object 

 
Rules (⚙) 
 

●​ Opens auto-assign rules panel 
●​ Configure component-based assignment 
●​ Set up automatic object detection 

 
Delete (✕) 
 

●​ Deletes the layer 
●​ Asks for confirmation 
●​ Doesn't delete GameObjects, only the layer organization 

Layer Operations 

Renaming Layers 
Method 1: Double-Click 
 

1.​ Double-click the layer name 
2.​ Type new name 
3.​ Press Enter to confirm, Escape to cancel 

 
Method 2: Context Menu 
 

1.​ Right-click the layer header 
2.​ Select "Rename Layer" 
3.​ Type new name and press Enter 

 
Tips: 
 

●​ Names can include spaces and special characters 
●​ Keep names under 20 characters for best display 
●​ Use consistent naming across your project 

Reordering Layers 
1.​ Click and hold on a layer header 
2.​ Drag up or down 
3.​ A blue line shows where it will be inserted 



4.​ Release to drop in new position 
 
Why Reorder? 
 

●​ Group related layers together 
●​ Put frequently-used layers at the top 
●​ Organize by workflow priority 

Duplicating Layers 
Right-click the layer header and choose: 
 
"Duplicate Layer (structure only)" 
 

●​ Creates a copy with same name, color, and settings 
●​ Copies auto-assign rules 
●​ Does NOT copy object assignments 
●​ Use for creating similar layers 

 
"Duplicate Layer + Objects" 
 

●​ Creates complete copy including all objects 
●​ Useful for variations or backups 
●​ Original and copy are independent 

Changing Layer Colors 
1.​ Click the ⚙ (gear) icon on the layer 
2.​ Click the color picker at top of rules panel 
3.​ Choose new color 
4.​ Color updates immediately in window and hierarchy 

 
Color Selection Tips: 
 

●​ Use similar colors for related layers 
●​ Bright colors for temporary/debug layers 
●​ Muted colors for background layers 
●​ Consider color-blind accessibility 

Deleting Layers 
Method 1: Delete Button 
 

1.​ Click the ✕ button on layer header 
2.​ Confirm deletion 

 
Method 2: Context Menu 
 

1.​ Right-click layer header 



2.​ Select "Delete Layer" 
3.​ Confirm deletion 

 
Important: 
 

●​ Deleting a layer does NOT delete GameObjects 
●​ Objects remain in the scene unchanged 
●​ Only the layer organization is removed 
●​ This action can be undone (Edit > Undo) 

 

Isolating Layers 
Quickly focus on a single layer by hiding everything else: 
 
Method 1: Shift+Click Eye Icon 
 

1.​ Hold Shift key 
2.​ Click the 👁 (eye) icon on any layer 
3.​ Everything in the scene is hidden 
4.​ Only objects in the clicked layer remain visible 

 
Method 2: Context Menu - Focus Layer 
 

1.​ Right-click the layer header 
2.​ Select "Focus Layer (hide other layers)" 
3.​ All other layers are hidden 
4.​ Objects not in any layer remain visible 
5.​ Multi-layer objects become visible if they're in the focused layer 

 
Method 3: Context Menu - Isolate Layer 
 

1.​ Right-click the layer header 
2.​ Select "Isolate Layer (hide everything else)" 
3.​ Everything in the entire scene is hidden 
4.​ Only objects in this layer are shown 
5.​ Complete isolation - perfect for detailed work 

 
When to Use Each: 
 

●​ Shift+Click (Isolate) - Fastest method, hides absolutely everything except this layer 
●​ Focus Layer - Hides other layers but keeps unlayered objects visible 
●​ Isolate Layer - Same as Shift+Click, complete isolation 

 
Tip: Isolate is perfect when you need to: 
 

●​ Work on detailed models without distraction 
●​ Review lighting on specific objects 



●​ Check object placement in isolation 
●​ Export or screenshot specific layer contents 

Layer Context Menu 
Right-click any layer header for these options: 
 
Focus Layer (hide other layers) 
 

●​ Hides all other layers 
●​ Objects not in any layer remain visible 
●​ Multi-layer objects become visible if in this layer 
●​ Quick way to reduce clutter 

 
Isolate Layer (hide everything else) 

●​  
●​ Hides EVERYTHING in the entire scene 
●​ Shows ONLY objects in this layer 
●​ Complete isolation for focused work 
●​ Same as Shift+clicking the eye icon 

 
Layer Rules 
 

●​ Opens auto-assign configuration 
●​ Same as clicking ⚙ button 

 
Scan Scene Now 
 

●​ Applies auto-rules to existing objects 
●​ Only available if rules are configured 

 
Select All Objects 
 

●​ Selects all objects in the layer 
●​ Shows object count 

 
Assign Selection 
 

●​ Adds selected objects to layer 
●​ Shows how many were added 

 
Remove Selection 
 

●​ Removes selected objects from layer 
●​ Only affects objects actually in the layer 

 
Rename Layer 
 



●​ Starts rename mode 
●​ Same as double-clicking name 

 
Duplicate Layer 
 

●​ Two options: with or without objects 
●​ Creates independent copy 

 
Delete Layer 
 

●​ Removes the layer 
●​ Asks for confirmation 

4. Working with Objects 

Adding Objects to Layers 

Method 1: Drag & Drop (Fastest) 
1.​ Select one or more GameObjects in Hierarchy 
2.​ Drag them onto a layer header in Scene Layers window 
3.​ Release to add 
4.​ Notification confirms how many were added 

 
Works with: 
 

●​ Individual GameObjects 
●​ Multiple selected GameObjects 
●​ Prefab instances 
●​ Objects from Project window (creates instances) 

Method 2: Assign Button 
1.​ Select objects in Hierarchy or Scene view 
2.​ Click the + button on desired layer 
3.​ Objects are added to the layer 

Method 3: Context Menu 
1.​ Select objects in Hierarchy 
2.​ Right-click layer header 
3.​ Select "Assign Selection" 

Method 4: Drag onto Expanded Layer 
1.​ Expand a layer (click the ▶ arrow) 
2.​ Drag objects from Hierarchy 



3.​ Drop between existing objects 
4.​ Blue line shows insert position 
5.​ Objects are added at that position in the layer's order 

Object Row Display 
When you expand a layer, each object shows: 

Left Side: Controls 
Eye Icon (👁) 
 

●​ Individual visibility control 
●​ Overrides layer visibility 
●​ Open: Visible, Closed: Hidden 

 
Lock Icon (🔒) 
 

●​ Individual picking control 
●​ Overrides layer lock 
●​ Open: Pickable, Closed: Locked 

Center: Object Information 
Object Icon 
 

●​ Shows Unity's default icon for the object type 
●​ Indicates prefab status (blue for prefab) 

 
Object Name 
 

●​ Shows the GameObject's name 
●​ Grayed out if object is inactive in hierarchy 
●​ Click to ping in Hierarchy 
●​ Double-click to select (or configure in Options) 

Right Side: Actions 
Select Button (✓) 
 

●​ Selects the object 
●​ Also pings it in Hierarchy 
●​ Quick way to find and focus on an object 

 
Remove Button (−) 
 

●​ Removes object from THIS layer only 
●​ Doesn't delete the GameObject 
●​ Doesn't affect other layers 



Removing Objects from Layers 

Method 1: Remove Button 
1.​ Expand the layer 
2.​ Click the − button next to the object 
3.​ Object is removed from layer 

Method 2: Selection Remove 
1.​ Select objects in scene 
2.​ Click the − button on layer header 
3.​ All selected objects are removed from that layer 

Method 3: Context Menu 
1.​ Right-click an object row 
2.​ Select "Remove from [Layer Name]" 

Reordering Objects 
Objects within a layer can be reordered: 

Drag to Reorder 
1.​ Expand a layer 
2.​ Click and hold on an object row 
3.​ Drag up or down 
4.​ Blue line shows insert position 
5.​ Release to drop 

 
Why Reorder? 
 

●​ Logical grouping (e.g., ground, mid-height, sky) 
●​ Priority ordering 
●​ Personal preference 
●​ Makes scanning the list easier 

Moving Between Layers 
1.​ Expand both source and destination layers 
2.​ Drag object from one layer 
3.​ Drop onto another layer's header OR between objects in expanded layer 
4.​ Object moves (doesn't copy) to new layer 

Multi-Layer Objects 
Objects can belong to multiple layers simultaneously. 



Adding to Additional Layers 
1.​ Object is already in "Environment" layer 
2.​ Also add it to "Collision" layer 
3.​ Object now appears in both layers 
4.​ Changes in one layer don't affect the other 

Visual Indicator 
In the Hierarchy window (if Layer Colors enabled): 
 

●​ Single layer: Solid color tint 
●​ Multiple layers: Striped colors 
●​ Stripe direction: Set in Options 

Finding All Layers for an Object 
1.​ Right-click an object row 
2.​ View "Also in layers:" section 
3.​ Lists all other layers containing this object 

Object Context Menu 
Right-click any object row for these options: 
 
Select 
 

●​ Selects the object in Unity 
●​ Pings in Hierarchy 

 
Ping in Hierarchy 
 

●​ Highlights object in Hierarchy without selecting 
●​ Useful for locating without changing selection 

 
Remove from "[Layer Name]" 
 

●​ Removes from current layer only 
●​ Object stays in other layers if applicable 

 
Also in layers: 
 

●​ Shows all other layers containing this object 
●​ List is for information only (not clickable) 

Object Click Behavior 
You can configure what happens when you click an object name: 
 



Ping Mode (Default) 
 

●​ Clicking highlights the object in Hierarchy 
●​ Selection doesn't change 
●​ Less disruptive to workflow 

 
Select Mode 
 

●​ Clicking selects the object 
●​ Opens in Inspector 
●​ Faster for editing properties 

 
Change in Options: Window > Scene Layers > Options > Clicking Object Row 

5. Layer Views 
Layer Views save complete visibility states so you can instantly switch between different 
working modes. 

What Views Remember 
When you save a view, it captures: 
 

●​ Which layers are visible (👁) 
●​ Which layers are locked (🔒) 
●​ Which layers are expanded (▼/▶) 

 
For every single layer in your scene. 

Creating a View 

Step 1: Set Up Your Scene 
1.​ Hide/show layers as desired 
2.​ Lock/unlock layers as needed 
3.​ Expand/collapse layers to your preference 

Step 2: Save the View 
1.​ Click the 💾 Save icon at the top of the window 
2.​ Enter a descriptive name (e.g., "Layout Mode") 
3.​ Choose a color for the view button 
4.​ Press Enter or click Save 

Step 3: View Appears 
●​ A colored button appears in the Layer Views section 



●​ Button uses the color you chose 
●​ Button text shows the view name 

Using Views 

Applying a View 
Method 1: Click Button 
 

●​ Simply click the view button 
●​ All layer states restore instantly 
●​ Notification confirms which view was applied 

 
Method 2: Context Menu 
 

●​ Right-click the view button 
●​ Select "Apply View" 

View Buttons 
View buttons automatically adapt to window width: 
 

●​ Wide window: Full text visible 
●​ Medium window: Abbreviated text 
●​ Narrow window: Initials only 

 
Colors remain consistent for easy identification. 

Managing Views 

Opening View Manager 
Click the ⚙ Settings icon next to the Save icon. 
 
The view manager panel shows all saved views with these controls for each: 
 
View Name 
 

●​ Double-click to rename 
●​ Press Enter to confirm, Escape to cancel 

 
Color Picker 
 

●​ Change the button color 
●​ Updates immediately 

 
Overwrite Button (🔄) 



 
●​ Updates the view with current layer states 
●​ Useful for refining a view after changes 
●​ No confirmation needed 

 
Delete Button (🗑) 
 

●​ Removes the view 
●​ Asks for confirmation 
●​ Cannot be undone 

Updating a View 
Method 1: Overwrite Button 
 

1.​ Set layers to new desired state 
2.​ Open view manager (⚙) 
3.​ Click 🔄 next to the view 
4.​ View is updated 

 
Method 2: Context Menu 
 

1.​ Right-click view button 
2.​ Select "Overwrite View" 

Deleting a View 
Method 1: View Manager 
 

1.​ Open view manager (⚙) 
2.​ Click 🗑 next to the view 
3.​ Confirm deletion 

 
Method 2: Context Menu 
 

1.​ Right-click view button 
2.​ Select "Delete View" 
3.​ Confirm deletion 

Common View Setups 

"Layout Mode" 
●​ Hide: UI, VFX, Audio visualizers 
●​ Show: Environment, Gameplay objects 
●​ Expand: Main gameplay layers 
●​ Use for: Level design, object placement 



"Lighting Mode" 
●​ Hide: Everything except lights and environment 
●​ Show: All light types, reflection probes 
●​ Expand: Lighting layers 
●​ Use for: Lighting passes, baking 

"Performance Test" 
●​ Hide: Expensive rendering (high-poly, complex VFX) 
●​ Show: Gameplay essentials 
●​ Use for: Testing frame rate, optimization 

"Final Review" 
●​ Show: Everything 
●​ Collapse: All layers 
●​ Use for: Seeing complete scene as players will 

"Debug Mode" 
●​ Show: Collision objects, triggers, debug helpers 
●​ Hide: Visual elements 
●​ Use for: Gameplay debugging, collision testing 

"Export Ready" 
●​ Hide: All editor-only objects, debug helpers 
●​ Show: Only game-ready content 
●​ Use for: Pre-export verification 

View Tips 
Keep It Under 10 Too many views becomes confusing. If you need more, consider if some 
can be combined or removed. 
 
Use Clear Names "Layout Mode" is better than "View 1". Names should indicate purpose at 
a glance. 
 
Color Code by Purpose 
 

●​ Blue tones: Work modes 
●​ Green tones: Complete/ready states 
●​ Yellow/Orange: Testing modes 
●​ Red tones: Debug/diagnostic modes 

 
Update Regularly As your scene evolves, update views to match current needs. Don't let 
views become outdated. 



6. Auto-Assign Rules 
Auto-assign rules automatically add objects to layers based on what components they have. 

Why Use Auto-Rules? 
Benefits: 
 

●​ Automatically organize new objects as you create them 
●​ Maintain organization as you add components 
●​ Scan existing scenes to quickly organize 
●​ Reduce manual clicking and dragging 
●​ Ensure consistency across scenes 

 
Use Cases: 
 

●​ Lighting layer: All objects with Light components 
●​ Audio layer: All objects with AudioSource components 
●​ VFX layer: All objects with ParticleSystem components 
●​ Physics layer: All objects with Rigidbody components 

Opening Rules Panel 
Click the ⚙ (gear) icon on any layer header. 
 
The rules panel shows: 
 

●​ Layer name and color picker at top 
●​ Current rules section (if any exist) 
●​ Quick Picks section (common Unity components) 
●​ Browse/Search section (all available components) 
●​ Scan Scene Now button at bottom 

Adding Rules 

Method 1: Quick Picks (Fastest) 
1.​ Open rules panel for a layer 
2.​ Look at "Quick Picks" section 
3.​ Click a component type button 
4.​ Rule is added immediately 

 
Available Quick Picks: 
 

●​ Light 
●​ Camera 
●​ MeshRenderer 



●​ SpriteRenderer 
●​ AudioSource 
●​ Rigidbody 
●​ Rigidbody2D 
●​ BoxCollider 
●​ BoxCollider2D 
●​ Collider 
●​ Animator 
●​ ParticleSystem 

Method 2: Search 
1.​ Type in the search field 
2.​ Browse filtered results 
3.​ Click "Add" next to desired component 
4.​ Rule is added 

 
Search Tips: 
 

●​ Type partial names: "audio" finds AudioSource, AudioListener, etc. 
●​ Use multiple keywords: "mesh render" for MeshRenderer 
●​ Case doesn't matter 
●​ Searches namespace and class name 

Current Rules Display 
Shows all rules currently configured for this layer: 
 

●​ Component type name (full namespace) 
●​ Remove button for each rule 
●​ Count of how many rules exist 

Removing Rules 
1.​ Click "Remove" next to any rule 
2.​ Rule is deleted immediately 
3.​ Already-assigned objects remain in layer 

Scanning the Scene 
After adding rules, apply them to existing objects: 
 

1.​ Click "Scan Scene Now" button 
2.​ Scene Layers searches all objects 
3.​ Matching objects are added to the layer 
4.​ Notification shows how many were added 

 
Important: 
 



●​ Only finds objects not already in the layer 
●​ Doesn't duplicate assignments 
●​ Scans entire scene (all hierarchies) 
●​ Includes inactive objects 

Real-Time Auto-Assignment 
Once rules are configured, they work automatically: 
 
New Objects: When you create a GameObject with a matching component, it's 
automatically added to the layer. 
 
Adding Components: When you add a component to an existing GameObject, if it matches 
a rule, the object is added to that layer. 
 
No Manual Work: Just create and work - Scene Layers handles the organization. 

Example Rule Setups 

Lighting Layer 
Purpose: Organize all light sources 
 
Rules to Add: 
 

●​ UnityEngine.Light 
●​ UnityEngine.ReflectionProbe 
●​ UnityEngine.LightProbeGroup 

 
Result: All directional, point, spot, and area lights automatically organized. 

Audio Layer 
Purpose: Find all audio sources 
 
Rules to Add: 
 

●​ UnityEngine.AudioSource 
●​ UnityEngine.AudioReverbZone 
●​ UnityEngine.AudioListener 

 
Result: All audio-related objects in one place. 

VFX Layer 
Purpose: Organize all visual effects 
 
Rules to Add: 
 



●​ UnityEngine.ParticleSystem 
●​ UnityEngine.VFX.VisualEffect 
●​ UnityEngine.TrailRenderer 
●​ UnityEngine.LineRenderer 

 
Result: All particle effects and trails organized. 

Cameras Layer 
Purpose: Track all camera objects 
 
Rules to Add: 
 

●​ UnityEngine.Camera 
 
Result: Main camera, secondary cameras, UI cameras all organized. 

Physics Layer 
Purpose: Find all physics objects 
 
Rules to Add: 
 

●​ UnityEngine.Rigidbody 
●​ UnityEngine.Rigidbody2D 
●​ UnityEngine.CharacterController 

 
Result: All physics-driven objects in one layer. 

UI Layer 
Purpose: Organize all UI elements 
 
Rules to Add: 
 

●​ UnityEngine.UI.Canvas 
●​ UnityEngine.UI.Image 
●​ UnityEngine.UI.Text 
●​ UnityEngine.UI.Button 

 
Result: All UI components organized automatically. 

Best Practices 
Start Broad, Then Specific Begin with general rules (e.g., "Light" for all lights), then create 
specialized layers if needed (e.g., "Directional Lights"). 
 
One Component Type Per Rule Each rule should match one specific component. Don't try 
to combine multiple types. 



 
Test with Scan After adding rules, use "Scan Scene Now" to verify they're catching what 
you expect. 
 
Review Auto-Assignments Occasionally check layers to ensure auto-rules are still 
appropriate as your scene evolves. 
 
Combine with Manual Assignment Auto-rules don't have to do everything. Use them for 
broad categorization, manual assignment for specific organization. 

7. Layer Presets 
Layer Presets let you save your entire layer setup and reuse it in other scenes. 

What Presets Save 
A preset captures: 
 

●​ All layer definitions (names, colors, visibility, lock states) 
●​ Auto-assign rules for each layer 
●​ All layer views (including their colors) 
●​ Expand/collapse states for each layer 

What Presets Don't Save 
Presets do NOT save: 
 

●​ Specific object assignments (these are scene-specific) 
●​ Object order within layers 
●​ Scene-specific GameObject references 

 
Why? Object assignments are tied to specific GameObjects via GlobalObjectId, which is 
scene-specific. Presets are designed to be scene-agnostic templates. 

Opening Preset Manager 
Click the preset icon (⚙) in the top-right corner of the Scene Layers window. 
 
The preset manager shows: 
 

●​ Save section at top 
●​ Scene management section 
●​ List of available presets 
●​ Load and delete options for each 



Creating a Preset 

Step 1: Set Up Your Layers 
Create and configure all layers exactly as you want them: 
 

●​ Layer names and colors 
●​ Auto-assign rules 
●​ Layer views 
●​ Default visibility and lock states 

Step 2: Save the Preset 
1.​ Click the preset icon (⚙) in top-right 
2.​ Enter a preset name in the "Save Current Setup" section 
3.​ Click "Save" button 
4.​ Preset appears in the list 

Step 3: Preset is Saved 
●​ Preset file is created in Assets/SceneLayers/Presets/ 
●​ File is named [PresetName].asset 
●​ Can be version controlled and shared 

Loading a Preset 

Step 1: Open Preset Manager 
Click the preset icon (⚙) in top-right corner. 

Step 2: Choose Run Rule Scan Option 
Toggle: "Run rule scan on load" 
 

●​ ✓ Enabled: Immediately assigns objects matching rules 
●​ ✗ Disabled: Just creates layer structure, no assignments 

Step 3: Load Preset 
1.​ Find desired preset in the list 
2.​ Click "Load" button 
3.​ Confirm (this replaces current layers) 
4.​ If rule scan enabled, objects are automatically assigned 

Managing Presets 

Viewing Preset Details 
Each preset in the list shows: 
 



●​ Preset icon 
●​ Preset name 
●​ Number of layers 
●​ Number of views 

Deleting Presets 
1.​ Click the ✕ button next to preset 
2.​ Confirm deletion 
3.​ Preset file is deleted from project 

Scene Management 
The preset manager includes scene management options: 

Clear All Layers 
Purpose: Remove all layers and start fresh 
 
Process: 
 

1.​ Click "Clear All Layers" button 
2.​ Confirm the action 
3.​ All layers and views are removed 
4.​ Scene database is cleared 

 
Use When: 
 

●​ Starting a new scene organization from scratch 
●​ Cleaning up before loading a preset 
●​ Resetting after experimentation 

Common Preset Use Cases 

Team Standards 
"Studio Standard Layers" 
 

●​ Create once with team-agreed layer structure 
●​ Everyone loads it for new scenes 
●​ Ensures consistency across project 
●​ Easy to update and redistribute 

Project Types 
"FPS Game Layers" 
 

●​ Weapons, Enemies, Cover, Pickups, etc. 
●​ Appropriate views for FPS development 



●​ Auto-rules for common FPS components 
 
"Archviz Layers" 
 

●​ Environment, Furniture, Lighting, Cameras 
●​ Views for client presentations 
●​ Rules for architectural elements 

 
"UI-Heavy Project" 
 

●​ Multiple UI layers for different screens 
●​ Animation layers 
●​ Background/foreground separation 

Personal Templates 
"My Preferred Setup" 
 

●​ Your personal layer preferences 
●​ Quick start for any new scene 
●​ Customize for your workflow 

8. Advanced Features 

Drag and Drop Details 

Drag Sources 
Scene Layers accepts drags from: 
 

●​ Unity Hierarchy window 
●​ Unity Scene view 
●​ Project window (prefabs) 
●​ Internal (reordering within Scene Layers) 

Drop Targets 
You can drop onto: 
 

●​ Layer headers (adds to layer) 
●​ Empty space in expanded layer (inserts at end) 
●​ Between objects in expanded layer (inserts at position) 
●​ Blue insertion line shows where objects will go 

Prefab Handling 
Dropping Prefab Assets: When you drag a prefab from Project window onto a layer: 



 
Option 1: Apply to Asset 
 

●​ Adds an auto-rule for this prefab type 
●​ All future instances automatically assigned 
●​ Existing instances can be assigned via "Also update existing instances" checkbox 

 
Option 2: Instantiate in Scene 
 

●​ Creates an instance in the scene 
●​ Adds that instance to the layer 
●​ Instance placed at scene view pivot point 

Search Functionality 

Basic Search 
Type in the search box to filter by name: 
 

●​ Searches both layer names and object names 
●​ Case-insensitive 
●​ Partial matches work 
●​ Results update as you type 

Search Results Display 
●​ Matching layers remain visible 
●​ Non-matching layers are hidden 
●​ Layers with matching objects are shown and auto-expanded 
●​ Matching objects are highlighted 
●​ Object count shown for matches 

Clearing Search 
●​ Click the "Clear" button next to search field 
●​ Or delete all text in search field 
●​ All layers become visible again 

Multi-Layer Management 

Objects in Multiple Layers 
Objects can belong to as many layers as needed: 
 

●​ Add to first layer normally 
●​ Add same object to additional layers 
●​ Each layer manages it independently 
●​ Removing from one layer doesn't affect others 



Visual Indicators 
In Scene Layers Window: 
 

●​ Object appears in each layer it belongs to 
●​ Context menu shows "Also in layers:" list 

 
In Hierarchy Window: (If Layer Colors enabled in Options) 
 

●​ Single layer: Solid color tint 
●​ Multiple layers: Striped pattern 
●​ Stripe direction: Vertical or Horizontal (set in Options) 

Keyboard Shortcuts 

General 
●​ Double-click layer name: Start rename 
●​ Double-click view name: Start rename 
●​ Double-click object name: Select (or Ping, based on settings) 

During Rename 
●​ Enter: Confirm rename 
●​ Escape: Cancel rename 
●​ Tab: Confirm and move to next field (if available) 
●​  

Layer Interactions 
●​ Double-click layer name: Start rename 
●​ Double-click view name: Start rename 
●​ Double-click object name: Select (or Ping, based on settings) 
●​ Shift+Click eye icon: Isolate layer (hide everything else) 
●​ Right-click anywhere on layer: Open context menu 

 

Undo Support 
Scene Layers fully supports Unity's Undo system: 
 

●​ Edit > Undo (Ctrl/Cmd+Z) 
●​ Edit > Redo (Ctrl/Cmd+Shift+Z) 

 
Undoable Operations: 
 

●​ Creating layers 
●​ Deleting layers 
●​ Renaming layers 



●​ Changing layer colors 
●​ Adding/removing objects 
●​ Creating/deleting views 
●​ Changing layer visibility/lock states 

Performance Considerations 

Large Scenes (1000+ objects) 
●​ Layer operations are optimized 
●​ Visibility changes use batch operations 
●​ No performance impact on Unity's runtime 
●​ Smooth scrolling even with many expanded layers 

Many Layers (50+) 
●​ No slowdown with many layers 
●​ Search helps manage large lists 
●​ Views provide quick navigation 
●​ Consider naming conventions for organization 

9. Options & Settings 
Access options via: Window > Scene Layers > Options 

Layer Colors 
Toggle: Show/Hide colored backgrounds in Hierarchy 
 
When Enabled: 
 

●​ Objects show their layer color as subtle tint in Hierarchy 
●​ Helps identify layer membership at a glance 
●​ Multiple-layer objects show striped pattern 
●​ Colors are subtle for readability 

 
When Disabled: 
 

●​ No visual indication in Hierarchy 
●​ Layer colors only visible in Scene Layers window 
●​ Cleaner Hierarchy appearance 
●​ Better for those who prefer minimal UI 

 
Default: Enabled 



Clicking Object Row 
Setting: What happens when you click an object name 
 
Option 1: Ping (Default) 
 

●​ Clicking highlights object in Hierarchy 
●​ Doesn't change selection 
●​ Less disruptive to workflow 
●​ Good for locating objects 

 
Option 2: Select 
 

●​ Clicking selects the object 
●​ Opens in Inspector immediately 
●​ Faster for 
●​ Clicking selects the object 
●​ Opens in Inspector immediately 
●​ Faster for editing properties 
●​ Good for rapid iteration 

Recommendation: 

●​ Use Ping if you frequently locate objects but don't always need to edit them 
●​ Use Select if you primarily use Scene Layers for quick access to properties 

Multi-Layer Objects 
Setting: Color Split Direction 

When an object belongs to multiple layers, it shows combined colors in the Hierarchy (if 
Layer Colors enabled). 

Option 1: Vertical Stripes (Default) 

●​ Colors appear side-by-side 
●​ Left to right progression 
●​ Works well with wide Hierarchy windows 
●​ Easier to distinguish individual colors 

Option 2: Horizontal Stripes 

●​ Colors appear stacked 
●​ Top to bottom progression 
●​ Works well with narrow Hierarchy windows 
●​ More compact appearance 

Note: This setting only affects Hierarchy display, not Scene Layers window. 



10. Tips & Best Practices 

Organization Strategies 

By Object Type 

Create layers based on what objects are: 

●​ Environment (terrain, buildings, props) 
●​ Lighting (directional, point, area lights) 
●​ Audio (sources, reverb zones) 
●​ VFX (particles, trails, effects) 
●​ UI (canvas, buttons, text) 
●​ Cameras 

Best For: Technical organization, clear separation of concerns 

By System 

Create layers based on gameplay systems: 

●​ Player System (player, input handlers, cameras) 
●​ Enemy System (spawners, AI, patrol paths) 
●​ Collectibles (pickups, rewards, objectives) 
●​ Environment Interaction (doors, levers, destructibles) 
●​ Save System (checkpoints, save points) 

Best For: Gameplay-focused projects, system-based development 

By State 

Create layers based on when objects are active: 

●​ Always Visible (core environment) 
●​ Conditional (doors, interactive elements) 
●​ Debug Only (gizmos, helpers, test objects) 
●​ Optional Content (side quests, secrets) 

Best For: Managing runtime states, optimization work 

By Detail Level 

Create layers based on visual complexity: 

●​ High Detail (close-up assets, hero props) 
●​ Medium Detail (standard environment) 
●​ Low Detail (distant objects, LODs) 



●​ Background (skybox, distant mountains) 

Best For: Performance optimization, LOD management 

Performance Tips 

Scene Complexity Management 

●​ Use layers to isolate expensive objects 
●​ Create "Performance Test" view that hides heavy rendering 
●​ Layer profiler targets separately for easier analysis 
●​ Toggle post-processing, particles, etc. by layer 

Build Preparation 

●​ Create "Build Ready" view showing only shippable content 
●​ Hide debug objects, editor-only helpers 
●​ Verify nothing essential is hidden 
●​ Use as pre-build checklist 

Iteration Speed 

●​ Hide UI while working on 3D environment 
●​ Hide environment while working on UI 
●​ Lock background to prevent accidental selection 
●​ Focus on one system at a time 

 

11. Troubleshooting 

Common Issues 

Objects Not Appearing After Scene Reload 

Symptom: After saving and reopening a scene, some objects don't appear in their layers. 

Cause: GlobalObjectId updates after scene load. Brief delay while Unity processes the 
scene. 

Solution: 

●​ Wait a few seconds after scene load 
●​ Objects will reappear automatically 
●​ No action needed - this is normal Unity behavior 



If objects truly missing: 

●​ Check if objects still exist in Hierarchy 
●​ Re-assign them to layers if necessary 
●​ Verify scene file saved correctly 

Can't See Layer Colors in Hierarchy 

Symptom: Objects don't show colored backgrounds in Hierarchy window. 

Cause: Layer Colors option is disabled. 

Solution: 

1.​ Window > Scene Layers > Options 
2.​ Enable "Layer Colors" toggle 
3.​ Colors appear immediately 

Can't Select Objects in Scene 

Symptom: Clicking objects in Scene view doesn't select them. 

Cause: Layer is locked (picking disabled). 

Solution: 

1.​ Find the layer containing these objects 
2.​ Check the lock icon (🔒) 
3.​ If closed, click to unlock 
4.​ Objects become selectable again 

Database File Missing 

Symptom: Error message about missing database file. 

Cause: The scene's layer database file was deleted or moved. 

Solution: 

1.​ Create a new layer in Scene Layers window 
2.​ Database file is automatically created 
3.​ Will be named [SceneName]_SceneLayers.asset 
4.​ Located next to your scene file 
5.​ Previous layer data is lost - need to recreate 

Preset Not Applying Correctly 

Symptom: Loading a preset doesn't create expected layers or rules. 

Cause: Preset file may be corrupted or incompatible. 



Solution: 

1.​ Try loading a different preset 
2.​ If that works, original preset may be damaged 
3.​ Recreate the preset from a working scene 
4.​ If none work, reinstall Scene Layers 

Search Shows No Results 

Symptom: Typing in search box shows "No layers or objects match". 

Cause: Search query doesn't match any layer or object names. 

Solution: 

1.​ Check spelling 
2.​ Try shorter search term 
3.​ Clear search and browse manually 
4.​ Verify layers and objects actually exist 

Performance Slowdown 

Symptom: Unity editor becomes slow when Scene Layers window is open. 

Cause: Very large scene with many layers/objects, or other performance issues. 

Solution: 

1.​ Close unneeded editor windows 
2.​ Use search to filter visible layers 
3.​ Collapse layers you're not using 
4.​ Check Unity's overall performance 
5.​ Restart Unity if problems persist 

Layer Reordering Not Working 

Symptom: Can't drag layers to reorder them. 

Cause: Search is active - reordering disabled during search. 

Solution: 

1.​ Clear the search box 
2.​ Reordering becomes available 
3.​ This prevents confusion during filtered views 

Objects Assigned to Wrong Layer 

Symptom: Objects appear in unexpected layers. 



Cause: Auto-assign rules may be assigning them automatically. 

Solution: 

1.​ Check layer's auto-rules (click ⚙) 
2.​ Review which components trigger assignment 
3.​ Remove rules if not desired 
4.​ Manually remove objects from unwanted layers 

Error Messages 

"No layers yet" 

Meaning: Scene has no layers created yet. Action: Click "New Layer" to create your first 
layer. 

"No objects selected" 

Meaning: Trying to assign objects but none are selected. Action: Select objects in 
Hierarchy first, then click assign button. 

"Object already in layer" 

Meaning: Trying to add object that's already assigned. Action: This is informational - no 
action needed. 

"Scene not saved" 

Meaning: Current scene hasn't been saved to disk. Action: Save scene (Ctrl/Cmd+S) 
before creating layers. Layer data requires saved scene. 

Data Recovery 

If Layer Data Appears Lost 

Scenario 1: After Domain Reload 

●​ Wait a moment - data is reloading 
●​ Check if database file exists next to scene 
●​ If file exists, data should reappear 

Scenario 2: After Scene Switch 

●​ Each scene has its own database 
●​ Layer data is per-scene, not global 
●​ Check correct scene is open 



Scenario 3: After Unity Crash 

●​ Check for scene backup files 
●​ Look for [SceneName]_SceneLayers.asset 
●​ If missing, layer data is lost 
●​ Will need to recreate from memory or preset 

Backup Strategy 

Recommended: 

1.​ Use version control (Git, Perforce, etc.) 
2.​ Commit scene files AND database files together 
3.​ Save presets of important layer setups 
4.​ Document layer organization in wiki 

12. Technical Reference 

Data Storage 

Layer Database File 

File: [SceneName]_SceneLayers.asset Location: Same folder as scene file Type: 
ScriptableObject Format: Unity asset (binary/YAML) 

Contains: 

●​ Layer definitions (names, colors, GUIDs) 
●​ Object assignments (as GlobalObjectId strings) 
●​ Auto-assign rules 
●​ Layer views 
●​ Default visibility/lock states 

Important: 

●​ One database per scene 
●​ Must be committed to version control with scene 
●​ Deleting this file loses all layer data 
●​ Can be manually edited in Inspector (not recommended) 

Object Membership 

Storage Method: GlobalObjectId strings 

Why GlobalObjectId: 

●​ Persists through scene reloads 



●​ Survives prefab operations 
●​ Unique per object per scene 
●​ Standard Unity identifier 

Limitations: 

●​ Scene-specific (can't reference across scenes) 
●​ Temporary objects (unsaved) won't persist 
●​ Requires scene to be saved 

UI State Storage 

Storage Method: EditorPrefs (Unity's editor preferences) 

Stored Per-Scene: 

●​ Foldout states (which layers are expanded) 
●​ Selected layer 
●​ Scroll position 
●​ View manager open/closed state 

Key Format: SceneLayers.[StateName].[SceneKey].[LayerGuid] 

Persistence: 

●​ Survives Unity restart 
●​ Survives domain reload 
●​ Survives scene switching 
●​ Per-user (not shared in version control) 

Object Order 

Storage Method: EditorPrefs 

Per-Layer Storage: List of GlobalObjectId strings in desired order. 

Persistence: 

●​ Survives Unity restart 
●​ Survives domain reload 
●​ User-specific 

Compatibility 

Unity Versions 

●​ Minimum: Unity 2021.3 LTS  
●​ Tested: 2021.3, 2022.3, 2023.3, 2024.1+  
●​ APIs Used: Standard Unity Editor APIs  



●​ Future: Should work with future Unity versions barring API changes 

Render Pipelines 

●​ Built-in Render Pipeline: ✓ Fully supported  
●​ Universal Render Pipeline (URP): ✓ Fully supported  
●​ High Definition Render Pipeline (HDRP): ✓ Fully supported  
●​ Custom Pipelines: ✓ Should work (uses standard APIs) 

Platforms 

Editor Platforms: 

●​ Windows ✓ 
●​ macOS ✓ 
●​ Linux ✓ 

Note: Scene Layers is editor-only. No runtime components. 

Package Manager 

Scene Layers can be used as: 

●​ Imported .unitypackage 
●​ Local package (package.json) 

Credits & Attribution 
Scene Layers for Unity Version 1.0.0 

© Copyright 2025 Cheeky Chops Labs 

Version History 

Version 1.0.0 - Initial Release 

●​ Complete layer management system 
●​ Layer views for visibility states 
●​ Auto-assign rules 
●​ Layer presets 
●​ Drag & drop support 
●​ Color-coded hierarchy 
●​ Per-scene databases 
●​ Multi-layer object support 
●​ Comprehensive documentation 

 



End of Manual 

For additional support and resources: cheekychopslabs@gmail.com 

Thank you for using Scene Layers! 


	Scene Layers - User Manual 
	Table of Contents 

	1. Introduction 
	What is Scene Layers? 
	Key Benefits 
	Core Concepts 
	Design Philosophy 
	Unity Version Support 

	2. Getting Started 
	Installation 
	Unity Package Manager 
	Verify Installation 

	Opening the Window 
	Interface Overview 
	Top Section: Layer Views 
	Middle Section: Layers 
	Bottom Section: New Layer Button 

	Your First Layer 
	Step 1: Create a Layer 
	Step 2: Add Objects 
	Step 3: Use the Layer 
	Step 4: Expand the Layer 

	First View 
	Create a View 
	Test the View 


	3. Layer Management 
	Creating Layers 
	Method 1: New Layer Button (Recommended) 
	Method 2: Context Menu 
	Method 3: Keyboard Shortcut 

	Layer Header 
	Left Side: Status Icons 
	Center: Layer Information 
	Right Side: Action Buttons 

	Layer Operations 
	Renaming Layers 
	Reordering Layers 
	Duplicating Layers 
	Changing Layer Colors 
	Deleting Layers 
	Isolating Layers 

	Layer Context Menu 

	4. Working with Objects 
	Adding Objects to Layers 
	Method 1: Drag & Drop (Fastest) 
	Method 2: Assign Button 
	Method 3: Context Menu 
	Method 4: Drag onto Expanded Layer 

	Object Row Display 
	Left Side: Controls 
	Center: Object Information 
	Right Side: Actions 

	Removing Objects from Layers 
	Method 1: Remove Button 
	Method 2: Selection Remove 
	Method 3: Context Menu 

	Reordering Objects 
	Drag to Reorder 
	Moving Between Layers 

	Multi-Layer Objects 
	Adding to Additional Layers 
	Visual Indicator 
	Finding All Layers for an Object 

	Object Context Menu 
	Object Click Behavior 

	5. Layer Views 
	What Views Remember 
	Creating a View 
	Step 1: Set Up Your Scene 
	Step 2: Save the View 
	Step 3: View Appears 

	Using Views 
	Applying a View 

	View Buttons 
	Managing Views 
	Opening View Manager 
	Updating a View 
	Deleting a View 

	Common View Setups 
	"Layout Mode" 
	"Lighting Mode" 
	"Performance Test" 
	"Final Review" 
	"Debug Mode" 
	"Export Ready" 

	View Tips 

	6. Auto-Assign Rules 
	Why Use Auto-Rules? 
	Opening Rules Panel 
	Adding Rules 
	Method 1: Quick Picks (Fastest) 
	Method 2: Search 

	Current Rules Display 
	Removing Rules 

	Scanning the Scene 
	Real-Time Auto-Assignment 
	Example Rule Setups 
	Lighting Layer 
	Audio Layer 
	VFX Layer 
	Cameras Layer 
	Physics Layer 
	UI Layer 

	Best Practices 

	7. Layer Presets 
	What Presets Save 
	What Presets Don't Save 
	Opening Preset Manager 
	Creating a Preset 
	Step 1: Set Up Your Layers 
	Step 2: Save the Preset 
	Step 3: Preset is Saved 

	Loading a Preset 
	Step 1: Open Preset Manager 
	Step 2: Choose Run Rule Scan Option 
	Step 3: Load Preset 

	Managing Presets 
	Viewing Preset Details 
	Deleting Presets 

	Scene Management 
	Clear All Layers 

	Common Preset Use Cases 
	Team Standards 
	Project Types 
	Personal Templates 


	8. Advanced Features 
	Drag and Drop Details 
	Drag Sources 
	Drop Targets 
	Prefab Handling 

	Search Functionality 
	Basic Search 
	Search Results Display 
	Clearing Search 

	Multi-Layer Management 
	Objects in Multiple Layers 
	Visual Indicators 

	Keyboard Shortcuts 
	General 
	During Rename 
	Layer Interactions 

	Undo Support 
	Performance Considerations 
	Large Scenes (1000+ objects) 
	Many Layers (50+) 


	9. Options & Settings 
	Layer Colors 
	Clicking Object Row 
	Multi-Layer Objects 

	10. Tips & Best Practices 
	Organization Strategies 
	By Object Type 
	By System 
	By State 
	By Detail Level 

	Performance Tips 
	Scene Complexity Management 
	Build Preparation 
	Iteration Speed 


	11. Troubleshooting 
	Common Issues 
	Objects Not Appearing After Scene Reload 
	Can't See Layer Colors in Hierarchy 
	Can't Select Objects in Scene 
	Database File Missing 
	Preset Not Applying Correctly 
	Search Shows No Results 
	Performance Slowdown 
	Layer Reordering Not Working 
	Objects Assigned to Wrong Layer 

	Error Messages 
	"No layers yet" 
	"No objects selected" 
	"Object already in layer" 
	"Scene not saved" 

	Data Recovery 
	If Layer Data Appears Lost 
	Backup Strategy 


	12. Technical Reference 
	Data Storage 
	Layer Database File 
	Object Membership 
	UI State Storage 
	Object Order 

	Compatibility 
	Unity Versions 
	Render Pipelines 
	Platforms 
	Package Manager 

	Credits & Attribution 
	Version History 
	Version 1.0.0 - Initial Release 



